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Chapter 1

Getting Started

r1

Introduction

Components of the Stereoscan 430

The Stereoscan 430 is a software-controlled digital scanning electron microscope.

Figure 1.1

The Column and Chamber

The Stereoscan 430 gun and column is used to generate and focus a fine beam of
electrons onto the surface of a specimen mounted in the specimen chamber. The
electron gun has a thermionic emitter as a source of electrons - the normal source is
a tungsten hairpin filament. Three electromagnetic lenses beneath the gun, focus and
shape the electron beam before it strikes the specimen in a scanned, or rastered,
fashion. The energy of the electron beam is adjustable from 300 volts to 30 kilovolts
in 10 volt steps and the electron probe current is continuously adjustable from 1
pico-amp to 1 micro-amp to suit the type of examination required.

The specimen chamber of the Stereoscan 430 holds the specimen to be viewed in

such a way that it may be freely manoeuvred during examination. The specimen
stage which holds the specimen is attached to the door of the chamber and is of the
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1.2.

manual cartesian type. The stage may be opened for examination once the vacuum
within the chamber has been vented.

The Vacuum System

The operation of the electron optical column and specimen scanning is dependent
not only on the presence of a vacuum, but also the degree of vacuum, i.e. the system
is safely interlocked so that it is not possible to switch on any of the high voltages
until an adequate vacuum is reached.

The vacuum system is simple and efficient. A turbomolecular pump, backed by a
rotary pump, is mounted on the lower face of the specimen chamber and
commences pumping when the system is being evacuated and comes to rest during
system venting. The electron gun and column are pumped through the tube running
from the chamber up to the gun section. The only valve in this system is the air-
admittance valve attached to the rear of the chamber, which automatically opens
when venting is requested. Normal operating vacuum should be in the range to 10
to 106 torr. No water cooling is required.

The Control Console

Complete software control of the Stereoscan 430 means that operation of the
instrument is rather like operating a desktop computer - all operations are controlled
through the mouse and keyboard. Within the console of the microscope, the
computer is used to communicate your operations and commands into actions by the
SEM. The PC environment used is Microsofts Windows.,, 3.1 and the SEM control
application (LEO) runs within this well known and easy to use system. Section 1.2
provides an introduction to Windows.,, and how to use the system of Help
provided. If you are unfamiliar with Windows.,,, the Windows,,, tutorial (selected
from Program Manager Help) is strongly recommended.

The right hand side of the console contains the standard internal hard disk drive (80
megabytes capacity or 105 megabytes optionally) and the standard floppy disk drive
just beneath the Leica logo. The floppy disk drive is used to read in or store data
files - such as images, microscope condition files or any of the files associated with
Windows.,, applications - as well as for loading system software or software
options. If any of the optional mass storage drives are fitted (WORM or Bernoulli,
for example), they will be mounted just below the floppy disk drive in the console
and are accessed just as any other disk drive within the user interface.

Windows,, and How to Use Help

The LEO software is a normal Windows.,, application running under Windows.,
Version 3.1. and therefore obeys all the usual rules of Windows,,, applications. If
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you are familiar with Windows.,, you already know the essential terms and
operations and are ready to learn how to use the Microscope.

If you are unfamiliar with Windows.,, you should read at least Chapters 1 and 2 of
the 'Windows,,, User's Guide' which is supplied with your system.

Obtaining Help

Comprehensive on-line Help for the LEO software is provided and may be accessed
in several ways:-

. Selected by function key
. Selected from a menu

. Selected by a button

. Context sensitive help

Function Key Selection of Help

The following function keys are used to obtain help:-

. F1 - Displays general help for the microscope, giving overviews
and providing a starting point for more detailed interrogation of
the help information

. <shift> F1 - Selects context sensitive help mode - see below

. F9 - Displays help on the use of special keys and key
combinations

. <shift> F10 - Displays how to use the Help system

Selecting Help from a Menu

Where Help is displayed in a menu (e.g. at the extreme right of the LEO top
window) selecting it will display the index to help relating to that window.

Selecting Help from a Button

Where a button labelled Help appears in a dialog box selecting it will display an
index of help relating to the dialog box functions.

Context Sensitive Help
This is frequently the most useful method of using Help.
To select this mode press the shift key and while holding it down press special

function key F1.
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1.3.1.

While in Context sensitive help mode the cursor will be displayed as

2

wherever help information is provided. In this mode mouse selections do not
perform their normal operations but display help on the specific item selected.

Some examples of what may be selected are:-

e A menu item - describes its function

¢ A window background - describes the function of the window

e A displayed parameter - describes the parameter, and under what
conditions it is enabled (useful to discover why a parameter is greyed
out)

¢ A toolbar Icon - describes it's function

e A Panel Background - describes its use and components

To switch off Context help mode press the <Esc> key while the context help cursor
is displayed.

The User Interface

Overview

The user interface is used to control the Stereoscan 430 and is a normal
Windows.,,, application. The minimum that may be on display is the Top Window
within which appears the Image Window. Other components may be called up as
required, either explicitly (e.g. by menu selection) or implicitly as an implied
response to some action or event. When the system is started up, you will also
usually have the Toolbar displayed.

The Mouse

Figure 1.2

The mouse is the primary adjustment and selection control of the microscope. As
such there are carefully defined conventions governing its use:-
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1. Selection and Dragging

The normal Windows,,, convention of pointing and clicking with the left mouse
button is used for menu selection, dragging and sizing of objects.

For example, the status window can be selected from the View menu by clicking
with the left mouse button on View in the menu bar and then clicking on the status
entry. The position of the status menu can then be altered by clicking on the title bar
of the status window and moving the mouse with the left mouse button held down.

2 Icon Selections

The left mouse button is also used to select icons. Selecting an icon will either
assign the adjustment parameters (displayed in the top right corner of the toolbar),
or cause the icon to execute immediately.

Examples of parameter assignment icons include the kV/Probe Current icon, the
Signal Level icon and the Mag/Focus icon. Immediate action icons include Scan
Rate + and - icons and the Run Up icon.

3. Parameter Adjustment

The left and middle mouse buttons are used for parameter adjustment when the
cursor is over the image window while adjust mode is selected. To adjust the
parameter displayed in the toolbar:-

Move the cursor over the image area

Select the left mouse button for the left toolbar parameter, or
Select the middle mouse button for the right toolbar parameter
Move the mouse to the left (while holding down the mouse
button) to decrease the parameter, or to the right to increase the
parameter

. ° & @

There are two speeds of adjustment available, coarse and fine. The selected
speed is displayed to the left of the adjustment parameters in the toolbar,
with (< >) for fine and (<< >>) for coarse. The speed can be toggled by
pressing the tab key.

For example, to adjust the magnification, select the Mag/Focus icon. This assigns
magnification control to the left mouse button. Now move the cursor over the image
and press the left mouse button. By holding the button down and moving the mouse
to the left, the magnification can be decreased. A movement to the right will
increase the magnification.
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Some parameters such as Beam Shift and Stigmation provide adjustment in both the
X and Y directions. This is indicated by the appearance of the adjustment icon in
the bottom left corner of the image.

4 Pop-up Menus

The right mouse button is used to display a pop-up menu while over the image.
Once the pop-up menu has been displayed, all selections on it are made with the left
mouse button.

The image is not the only interface component which has a pop-up menu
associated with it. Most objects which do not have their own menu have a
pop-up menu which is displayed with the right mouse button.

5. Panel Selection

There is one other use for the right mouse button which is to bring up the control
panel associated with each icon. This is done by putting the cursor over the icon and
selecting the right mouse button.

The control panels are not unique to the icon, so more than one icon may
bring up any given control panel.

Once the control panel has been displayed selections can be made with the left
mouse button.

With the mouse pointer positioned over the image, the right mouse button obtains a
pop-up menu allowing further mode selection, e.g. Annotation.

A little practice will be required to gain familiarity with the three button mouse.
However, it is an extremely quick and convenient method of SEM control.

The Keyboard

In addition to mouse control of parameters, many keyboard keys have been assigned
special functions and these can sometimes be a valuable aid to instrument operation.
The keys have been designated (also to be found by pressing F9 - keys Help) as
follows:-

F1 Help (see 1.2)
F1 + Shift Context sensitive Help (see 1.2)

F2 Performs a lens hysteresis correction for all column lenses. This has the
effect of improving the accuracy of both the Probe current indication and
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the magnification, which in turn improves the accuracy of on-screen
measurement.

F2 + Shift Toggles the toolbar at the top of the screen on and off.

F3 Closes all additional Windows other than the toolbar and status
window. This also closes any currently iconised Windows.

F3 + Shift Toggles the PC-plane (i.e. the Windows plane) on and off.
When the PC plane is off, the space bar can be used to switch it back on.
This is particularly useful for viewing the full size image without
obstruction by any menus which might need to be kept open.

All keyboard commands remain active.

F4 is used to step through each entry in the magnification table (Tools -
Mag Table). Selection of a mag-table entry does not lock out normal
operation of the instrument.

F4 + Shift exits from mag-table mode. Re-entry into mag-table mode then
re-commences at the first entry.

F5,F6,F7,F8 (with or without shift) Executes the installed macro (if it
exists). If the macro does not exist, a 'beep' is given.

F9 Help on key usage
F10 Menu

F11 Selects the Annotate/Measure function and toggles between Move and
Edit modes.

F11 + Shift Toggles the Datazone overlay on and off.

Tab Toggles coarse and fine adjustment mode (< > to << >>)
Esc Aborts the currently executing auto function or macro.
Pause Pauses/resumes execution of a macro.

A Performs an auto-stigmation routine. This may be aborted by pressing
the Esc key.
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B If B is pressed, the arrow keys may be used to control Beam Shift, or
fine image movement.

F starts an autofocus routine. This may be aborted by pressing the Esc key.
Note also that the area used for autofocus, a reduced area at the centre of
the screen, may be moved after obtaining the image pop-up menu and
selecting Focus Area.

I If L is pressed the arrow keys may be used to adjust the two parameters
currently displayed in the image window. The left/right keys decrease and
increase the left parameter and the up/down keys increase and decrease the
right parameter. If the arrow keys are temporarily allocated to any other
parameter (e.g. by pressing BM,S or Z), the keys may be returned to the
default mode by pressing .

M If M is pressed the arrow keys are temporarily assigned to control
magnification and focus. The left/right keys increase and decrease the
magnification whilst the up/down keys increase and decrease the focus.

If Optibeam is switched on, focus means Working Distance. If Optibeam is
off, focus means C3 lens current.

+ is used to increment through the available scanning rates.
- is used to decrement through the available scanning rates.
Space is used to reveal the PC plane if hidden by shift-F3.

Alt followed by arrow key movements allow navigation of the pull-down
menus of the currently selected (highlighted in the title bar) window.

These key designations are in addition to the keys already designated for
Windows.,, operation - consult Windows.,, Help for a list of these keys. One
particularly useful keyboard shortcut is Alt/Tab which enables fast switching

from one Windows.,, application to another. To use, hold down the Alt key
and repeatedly press Tab until the title of the required application is shown
and then release the Alt key. The selected application then becomes the
current application.
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1.3.3. The Top Window

file \[Iew Beam [Detectors Edit S-:amh; Slzqux ]'uds I_Ieln

LIEE =D

s
T ——

Figure 1.3

The top window provides the environment within which the other Windows reside.
[t contains:-

. The caption bar, which displays the Version number of the LEO
software in use together with the release date. In some
circumstances, the caption bar displays messages to the user.

® The System button permitting the system to be shutdown or put
into Standby mode.

. The minimise button which enables the user interface to be
iconised while leaving the SEM operational.

. The reduce/full size button allows you to work with the Top

Window at a reduced size or at full screen size by alternate clicks.

. The top level menu from which all system operations may be
selected. Help may also be selected from this level. Context
sensitive Help (shift-F1) may be used to obtain help on each
function.
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1.3.4. The Image Window

The image window is used to display the live image, and may either occupy the
whole screen or a quarter of the screen as selected by the top menu selection
View->Full screen image. When in quarter screen mode it may be moved with the
mouse by dragging the caption bar. The caption bar indicates the current mode and
implies how the mouse is to be used.

Quarter screen mode is especially useful when other Windows such as profile or
status etc are to be displayed simultaneously. They can be moved and sized
separately to give the required screen arrangement.

1.3.5. The Toolbar

Fle Yiew Beam [etectors Image Edit Scanning StagefVac Jools Heip

Figure 1.4

The toolbar is displayed at the top of the main window and provides access to
commonly used functions. The toolbar consists of a fixed portion and a variable
portion. The fixed portion makes up the right half of the toolbar and displays the
current mouse adjustment parameters (e.g. Mag and Focus), the state of the vacuum
system (e.g. Ready, Venting or Pumping), the state of the EHT system (e.g. Manual,
Shutdown, Beam On etc.), coarse/fine adjustment icon (< > for fine, << >> for
coarse) and the identity of any currently executing macro function.

The variable portion contains icons which may be selected with left or right mouse
buttons to perform required operations. A standard set of icons is provided,
although different sets of icons may be loaded according to the application
requirements and operator skill level, i.e. Novice or Expert. Novice mode provides
two rows of large icons whilst Expert mode provides three rows of small icons.

The operational convention adopted is that the left mouse button initiates an action
or adjustment mode, the right button displays a panel associated with the selected
function which may be used for more detailed setting up or control.

The toolbar itself may be disabled from the top menu View->Toolbar.

1.3.6. Other Components

As a result of menu actions or other events, various other interface components may
be displayed. These are:-
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Select Reset File
Beam Current= 400. yA
Collector Blas= 400. V
EHT=20.00 kV

Flll= 268 A

Fllament Age=114.57 Hours
Fllament Type= Tungsten

| Probe=743.4 pA

Output dev= P78B video print
Plxel Avg.= 32

System Vacuum=7.86e-007 Torr

Figure 1.5
Status Window

This displays a user selected group of instrument parameters which are continuously
updated.

Individual items can be selected or deselected from within the status menus select
window. In addition files of status menu selections can be saved and loaded from
within the Status File Menu.

Datazone

The datazone displays information concerning the current state of the system, and
since it is a form of annotation (displayed in the overlay plane), it may therefore be

included in exported and hard-copied images etc.

The datazone is only displayed in full screen image mode. Its contents and position
is user definable from within the annotation plane control pop-up menu.

The datazone may be switched on and off from the main window menu selection
View->Datazone.
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Figure 1.6
Magnification Control Window

This window may be invoked from the top menu Image->Mag/Foc function and is
used to set the base magnification of the instrument to a specific value. The use of
the magnification control window is fully described in Section 2.3.4 Setting Focus
and Magnification.

B Beamshift [H
-

Figure 1.7

Navigation Box - (Top menu selection View->Nav box).

The navigation box provides visual indication of the range and current value of one
and two dimensional parameters. Any variable may be selected to the Navbox by
selecting the parameter within the status window or toolbar, however not every
parameter is well suited to this type of control (e.g. parameters with non-linear
control characteristics such as magnification and probe current).

The edges of the box represent the limits of the variable range (e.g. - 100%, +
100%) and cross hairs indicate the centre of the box, not necessarily the centre of
the range. The current parameter value is indicated by a red marker. The parameter
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value may be adjusted by dragging the marker to the required position. Alternatively
the X and Y values may be individually adjusted using the scrollbars and the
parameters set to zero using the origin button (labelled with O) at the junction of the
X and Y scrollbars. If this button is selected the current parameters are set to zero.

This method of adjustment is also to be found within control panels such as
Stigmation.

Starting Up and Closing Down the Stereoscan 430

Starting up and closing down the Stereoscan 430 is very simple, however it is
important to follow the routines described here:-

Starting Up from Cold

The Standby button above the disk drive will be illuminated. Press the On button,
the system automatically loads up to Program Manager in Windows - this takes
about a minute, during which time the DOS loading messages will be seen. Note
also that when the program manager first appears, an icon showing traffic lights will
be seen at the lower left of the screen. This indicates that SEM initialisation is
taking place and finishes when the green light is displayed. This icon will remain
until LEO is started.

Locate the LEO UIF icon and double-click it. This starts the user interface loading
during which a loading message is displayed and a dialog box appears to prompt for
the user directory to start in.

After complete loading of the user interface (the hourglass icon disappears) imaging
may be started by pressing the Start icon (provided that the vacuum status is Ready).

At this point it would be a good idea to optimise the gun and imaging conditions
(see Chapter 2 Operation).

Starting Up from Standby

Locate the LEO standby icon and double-click it. The system will be restored to the
state it was in when last used.

Shutting Down
When a working session on the microscope has finished and the microscope is to be

left overnight, over the weekend or longer, there are two ways to close down the
system:-
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1.38.

Standby

This is the recommended state to leave the system in overnight and is again selected
from the system button at the top left of the screen. Note that this is a software
standby, not to be confused with the standby button above the disk drive which
switches off power to the computer. Having selected SEM Standby, the software
puts the SEM into standby mode. This includes setting the EHT, Lens currents,
HRRU (if fitted), imaging and overlay planes to standby conditions. This is
indicated by the user interface iconising with the text SEM Standby.

Shutdown

This is the recommended state to leave it for two days or longer. Click on the
system button at the top left of the screen and select SEM Shutdown. You will be
asked if you wish to save the current operating conditions - if you choose yes, then
the conditions are stored in a file called Restore.Leo, which is a macro and can be
used to restart the system later. The software then goes through a controlled
shutdown, during which important files are written to disk - on no account press the
Standby button or power off at this point. When the Program Manager can again be
seen, close this down in the same way i.e. from the system button, then press the
Standby button. Starting up again is then as described in Section 1.4.1 To Obtain an
Image later in this Chapter.

It is quite a good idea either to switch off the viewing monitor or switch on a
screen-saver (such as provided in the Program Manager/Main/Control
Panel/Desktop menu) to prevent any burning of the screen.

Some Important Do’s and Don'ts

Do

e  Use the software routines provided for shutting down and standby mode

e  Check filament saturation, as described, after the first runup of a new
session

e Create user directories as necessary and keep all user data within them

e Read the Help provided. It is there for your guidance

e Try to keep a note of any important error messages for diagnostic purposes

e Call your local Leica customer care office in the event of problems

e Keep the chamber door and gun "O" rings clean

e Fill the hard disk with images, use floppies where possible or use a mass
storage disk
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14.

14.1.

e Try to edit or alter, in any way, the system files. This will cause operational

problems
e Try to install any peripheral without first seeking advice from Leica

Cambridge
Common Operating Routines

To Obtain an Image

Before commencing to turn on the filament there should be a sample inside the
chamber and there should be a satisfactory vacuum, i.e. Vacuum Ready displayed.
The vacuum status and operating status are displayed towards the right of the
toolbar.

If the vacuum is satisfactory Ready will be displayed, and the operating status will
display Shutdown. If the operating status displays Beam OfT, this indicates that a
run-up file has been loaded but the filament has subsequently been turned off.

After loading the control program the image area may be displayed at 1/4 full screen
size. The operator may, at any time, change the displayed image to full screen size.
This can be done by selecting View (with the left button) from the top row of the
toolbar and then selecting Full Screen Image from the drop down menu. Similarly
the datazone can be displayed by selecting Datazone from this same drop down

menu.
The datazone will not be displayed while the image area is displayed at 1/4

full screen size, and while this mode is set the option of displaying the
datazone is greyed out, so that it cannot be selected.

Clicking with the left button over the Run Up icon

will cause a macro called RESTORE.LEO to be loaded and executed. This macro
holds all the operating conditions of the SEM and corresponds to the last set of
operating conditions that were saved when the microscope was shutdown.

Should the operator require other specific operating conditions please refer to
Saving and Loading Conditions in Section 2.7.2.
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This operation will take several seconds, during which time the macro will appear
and then be executed. When the macro has been removed and MANUAL displayed
in the toolbar the SEM is ready to use. Normally there will be some form of
recognisable image displayed on the screen, at worst it may show only as a change
in signal brightness.

The following steps should provide the operator with an image of the sample with
which to work.

Adjust the Image Brightness to a Suitable Level

Set the mouse control to Brightness and Contrast control by clicking with the LEFT
button over the icon

With the mouse pointer over the image hold down the LEFT button and slide the
mouse either left or right to decrease or increase the image brightness to a
satisfactory level.

Select a Very Low Magnification, i.e. about 20X

Set the mouse control to Magnification and Focus by clicking with the LEFT button
over the Mag/Focus icon. Then, with the mouse pointer over the image hold down
the LEFT button and slide the mouse to the left to reduce the magnification. The
value of the magnification will decrease while this operation is continued, or
repeated, until the minimum value is attained.

Focus the Image

Unless already selected, set the mouse control to Magnification and Focus control,
by clicking with the Left button the Mag/Foc icon. Place the mouse pointer over the
image and hold down the CENTRE button and then slide the mouse to the left or
right until the image becomes more recognisable and into focus.

If difficulty is experienced, note the value of the focus displayed in the toolbar.

Most samples will usually be in focus somewhere within the range Smm to 30mm. If
the sample is out of the field of view altogether, then an image of part of the stage
mechanism or even of the mesh covering the turbo-molecular pump, may be
produced, to do this a focus distance greater than about 30mm is required. If this is
the case, the sample will have to be moved into the field of view by manually
moving the stage X and Y controls mounted on the door of the chamber. The
simplest thing is to move the controls until both X and Y position counters indicate
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approximately 0500. This will place the stage at the centre of its travel and, if a
single stub is mounted in the chamber this will now be under the beam, or if the
carousel is present, the centre of this will be under the beam. Repeat the above
focusing operation to achieve a recognisable image.

Optimisation of Settings

Once a recognisable image has been obtained the operator can optimise the
conditions prior to examining the sample in detail. The following procedures should
be done at the start of a session, but any part of the following can be repeated
subsequently, should the operator feel it necessary.

Setting kV and Probe Current

The accelerating voltage to be used will depend greatly upon the sample being
examined, and will require some experimentation by the operator to achieve the best
results. As a rough guide, uncoated non-conductive samples should be examined
using between 1 and 3 kV, non-conductive but coated samples should be examined
using between 5 and 15 kV and conductive samples can be examined using between
10 and 25 kV.

It is recommended that inexperienced users start with a conductive sample and set
the accelerating voltage to 15 kV and the probe current to 200 pA.

To Adjust the kV

Set the mouse control to kV and probe current control by clicking with the Left
button over the icon

The current values of the kV and probe will be displayed in the toolbar. Then with
the mouse pointer over the image, hold down the Centre button and slowly move
the mouse to the left or right to decrease or increase the kV to the desired value.

To Adjust the Probe Current
If not already active, set the mouse control for kV and probe adjustment by clicking

on the icon with the Left button. With the mouse pointer over the image hold down
the Left button and slowly slide the mouse to the left or right decrease or increase
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the probe current to the desired value. It may then be necessary to adjust the
brightness of the image as described above.

The value of the probe current chosen will affect the signal to noise level within the
displayed image, and also the achievable resolution. A large probe current will
produce a good noise free image, but it will not be possible to obtain good
resolution at higher magnifications, and conversely a low probe current will enable
high resolution images to be obtained but the image will become progressively more
noisy as the probe current is decreased. Inexperienced operators may choose to run
in the Auto-probe mode when the magnitude of the probe current is varied as the
magnification is changed, see Section 2.3.2 Setting EHT and Probe Current.

Any parameter assigned to mouse control may be set directly by double
clicking on that parameter display in the toolbar. A number entry box
appears allowing the value to be typed in.

Setting the Filament Current and Beam Alignment

Filament Setting

The setting of the filament current will have a large effect of the brightness and
stability of the image, as well as influencing the lifetime of the filament. As the
filament current is increased the brightness of the signal increases until a small
plateau is reached, this is known as the "first peak" (see Figure 1.8), increasing the
filament further will again cause the signal brightness to increase until another
plateau is reached, further increase of the filament current will not improve the
signal brightness, this is referred to as the fully saturated condition. The lifetime of
the filament decreases as the filament current increases, there is no advantage in
increasing the filament current above the just saturated condition.

2nd peak

1st peak \

Source \
Brightness

Filament |

Figure 1.8
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The filament should be operated at one of two conditions, either at the first peak
setting or where the filament has become just fully saturated. These two positions
will provide conditions for stable brightness operation. Operating at the first peak
setting will give a long filament life, but is not satisfactory for high resolution
imaging, while the fully saturated condition will give the brightest signal and allow
the best resolution images to be obtained, but the lifetime of the filament will be
reduced.

The above conditions can be achieved by selecting the Filament Current icon and
slowly increasing filament current (having selected manual brightness control)
while observing the points at which maximum brightness occurs. The two peaks of
maximum brightness correspond to the two saturation peaks.

The filament current may be varied by using the associated scroll bar within the Gun
Alignment panel, either by SLOWLY dragging the slider in the appropriate
direction, or by clicking over the arrow at the appropriate end of the scroll bar.

Alignment

For the best performance of the microscope the electron beam should pass down the
column along the electron optical axis, and any aperture in use should also be
centred about this axis. As no column can be perfect, various adjustments are
provided to compensate for this.

Final Aperture Alignment

The centring of the final aperture can easily be checked by having a recognisable
feature at the centre of screen and then taking the focus through focus and back
again. When aligned, the image will only rotate and not shift laterally. If the
aperture is mis-aligned the image will move backwards and forwards across the
screen in a slight arc. If the aperture is mis-aligned it will be necessary to move the
position of the aperture using the X and Y controls on the side of the column until
the image ceases to shift laterally.

Focus Wobble

To facilitate setting the optimum aperture position the operator may find it helpful
to select Focus Wobble. This may be selected from the Gun Align panel or directly
from the drop down menus under Beam.

When selected, this automatically sweeps the objective lens backwards and
forwards through focus, the speed and amplitude of the sweep can be altered from
the Wobble panel. Selecting or de-selecting Fast will change the speed from fast to
slow, and using the Amplitude scroll bar will enable a suitable excursion of the
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sweep to be set. Selecting reduced raster and a fast scan speed will also facilitate
this operation.

Adjust the X and Y aperture micrometers carefully until the images ceases to shift
laterally and only rotates. The Focus wobble can then be de-selected by selecting
Off from within the Focus Wobble panel.

Beam Alignment

The beam is correctly aligned down the column when the brightness level of the
signal cannot be increased any further (ensuring the system is switched to
MANUAL brightness control) by any adjustment of the gun align screws. These
are moved as opposite pairs where one is slackened and the other screwed in. Both
pairs should be adjusted against each other until the signal brightness is at a
maximum. This adjustment should be carried out in conjunction with the filament
current adjustment, if the optimum settings are to be achieved.
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